AVAYA

Avaya Softconsole™

Release 1.0
Quick Reference

555-233-773
Issue 1
March 2002



Copyright © 2002, Avaya Inc.
All Rights Reserved
Printed in USA

Notice.

While reasonable efforts were made to ensure that the information in this
book was complete and accurate at the time of printing, Avaya can
assume no responsibility for any errors. Changes and corrections to the
information contained in this document may be incorporated into future
reissues.

Your Responsibility for Your System’s Security.

Toll fraud is the unauthorized use of your telecommunications system by
an unauthorized party, for example, persons other than your company’s
employees, agents, subcontractors, or persons working on your com-
pany’s behalf. Note that there may be a risk of toll fraud associated with
your telecommunications system and, if toll fraud occurs, it can result in
substantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your sys-
tem, such as programming and configuring your equipment to prevent
unauthorized use. The system manager is also responsible for reading all
installation, instruction, and system administration documents provided
with this product in order to fully understand the features that can intro-
duce risk of toll fraud and the steps that can be taken to reduce that risk.
Avaya does not warrant that this product is immune from or will prevent
unauthorized use of common-carrier telecommunication services or facil-
ities accessed through or connected to it. Avaya will not be responsible for
any charges that result from such unauthorized use.

Avaya Fraud Intervention.

If you suspect that you are being victimized by toll fraud and you need
technical support or assistance and are within the United States, call the
Technical Service Center Toll Fraud Intervention Hotline at 1 800 643-
2353. If you need technical support or assistance and are outside of the
United States, contact the International Technical Assistance Center
(ITAC) at US code 303 804-3777.

Warranty.

Avaya provides a limited warranty on this product. Refer to the “Limited
Use Software License Agreement” card provided with your package.
Trademarks. Softconsole is a trademark of Avaya, Inc. Other product and
brand names are trademarks of their respective owners. All rights
reserved.
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Quick Reference

Logging In and Exiting

This booklet contains basic instructions for using the Avaya Softconsole™
Release1.0 for Avaya call processing systems versions R9 and later. For detailed
instructions, or for information on using the Softconsole application in Centralized
Attendant Service (CAS) and Distributed Communications Systems (DCS)
environments or alternative configurations, refer to the Avaya Softconsole™
Release 1.0 Attendant’s Guide.

The following procedures explain how to access Softconsole. To determine which
of these login procedures (if any) you must use, see your system administrator.

Start a Softconsole session

1. Double-click on the Softconsole icon.
If you are not required to enter a login name or password, the Softconsole
window opens. Otherwise, go to
Step 2.

2. Enter your login name and password (if applicable).
3. Press ENTER, or click OK.
=>» NOTE:
If you are working in an Internet Protocol (IP) configuration, you must also

log into the Avaya call processing system server before you can use
Softconsole. See “Log into IP configurations,” on the next page.
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Identify yourself to Softconsole

If your Softconsole is configured for multiple attendants and another attendant has
been working in a Softconsole session at your computer, you must identify
yourself to Softconsole before you can begin your session.

1. From the File menu, click Change Attendant to display the login dialog
box.

2. Enter your login name and password.
3. Press ENTER, or click OK.

Exit a Softconsole session

=> NOTE:
If you are working in an IP configuration, follow the procedure in “Log off IP
configurations,” on the next page, to end your Softconsole session.

1. Before you choose to exit your Softconsole session, be sure that no calls
appear on the console.
2. From the File menu, click Exit.
=>» NOTE:
If the console detects any calls in progress, a warning dialog box is

displayed. Click Cancel in the dialog box to return to your Softconsole
session without disconnecting calls.

Log into IP configurations

If you are working in an IP configuration, you must complete this procedure to log
into the call processing system server. After you successfully start the Softconsole
application, you see the IP Login window.

1. Start Softconsole according to the procedure in “Start a Softconsole
Session,” on the previous page.

2. At the IP Login window, enter the following information in the appropriate
boxes:

m your assigned extension
m your password
=>» NOTE:

This login information is provided by your call processing
system administrator.
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Logging In and Exiting

3. Do one of the following (optional):

= If you want the application to save your password for the next time
you log into the server, mark the Remember password for next
login session check box.

= If you want the application to log into the server automatically the
next time you start a Softconsole session, mark the Automatically
login if possible when application restarts check box.

4. Click Login.

=—>» NOTE:
Depending on your configuration, an additional dialog box may appear
prompting you to verify the connection by making a test call. To verify the
connection, click OK.

Log off IP configurations

1. Before you choose to exit your Softconsole session, be sure that no calls
appear on the console.

2. From the File menu, click IP Login.
3. From the IP Login menu, click Logoff Switch.
=>» NOTE:
If the console detects any calls in progress, a warning dialog box is

displayed. Click Cancel in the dialog box to return to your Softconsole
session without disconnecting calls.

Get help

To get immediate on-line help, press F1.
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Basic Call Handling

Hot Key Summary

“Hot keys” are specific key combinations (for example, ALT-K or CTRL-D) that can
be programmed by your Softconsole administrator for particular toolbar and menu
options. For example, pressing ALT-M allows you to send email to a selected
directory entry. If hot keys have been programmed for your Softconsole, you can
substitute the appropriate hot key in any of the procedures provided in this
booklet. You may find it useful to record additional hot keys programmed for your
system in the table below.

Hot Key Assigned Function

ALT-O Opens the Action menu

ALT-F Opens the File menu

ALT-V Opens the View menu

ALT-A Opens the Features menu

ALT-D Opens the Directory menu

ALT-T Opens the Trunks menu

ALT-H Opens the Help menu

ALT-I Displays information (call
appearance, second party detail,
etc.)

ALT-M Initiates email to a selected directory
entry

ALT-1 through Allows direct keyboard selection of

ALT-6 specific call appearances

ALT-S Shows the line status of a selected
directory entry
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Basic Call Handling

Answer a call

1. Do one of the following:

= If the Pickup Indicator border appears on the associated call
appearance, press F4 (Pickup).

m Press ALT and the key (1 to 6) corresponding to the appropriate call
appearance.

m Click on any part of the call appearance, except the information
button or comment area.

2. Assist the caller as necessary.
=> NOTE:

To answer a second call, press F8 to place the current call on hold.
Then, follow steps 1 and 2.

Call an extension

1. Do one of the following:

m Press F3 (New). Then, use the keyboard to dial the extension
number.

m Press ALT and the key (1 to 6) corresponding to an available call
appearance. Dial the extension.

m Left-click on the Direct Extension Select/Busy Lamp Field
(DXS/BLF) cell corresponding to the extension.

m Locate the extension in the appropriate Softconsole directory. Press
ENTER to dial the extension for the selected entry.

2. If the extension is busy or does not answer, press F9 (Release) and try
again later.

Call an outside telephone number

1. Do one of the following:
m Press F3 (New). Then, dial the appropriate trunk access code.

m Press ALT and the key (1 to 6) corresponding to an available call
appearance. Then, dial the appropriate trunk access code.

m Click the appropriate Trunk Group Select button (or select the trunk
group from the Trunk menu).

2. When you hear dial tone, dial the telephone number.

3. If the telephone number is busy or does not answer, press F9 (Release)
and try again later.
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Place a second call (Auto Hold)

To place a second call while already active on a call (when Auto Hold is
administered for your Avaya call processing system):

1. Do one of the following:
m Press F4 (Pickup) to select the next available call appearance.

m Press ALT and the key (1 to 6) corresponding to an available call
appearance.

m Click on any part of an available call appearance, except the
information button or comment area.

2. Dial the extension or telephone number (including the trunk access code).

3. If the called party is busy or does not answer, press F9 (Release) and try
again later.

Place a second call

To place a second call while active on a call (when Auto Hold is not administered
for your Avaya call processing system):

1. Press F8 (Hold) to place the current call on hold.
2. Use the up and down arrow keys to select an available call appearance.
3. Dial the extension or telephone number (including the trunk access code).

4. If the called party is busy or does not answer, press F9 (Release) and try
again later.

Place the current call on hold

To hold the current call, press F8 (Hold). You can now use the up and down arrow
keys to retrieve the next held call.

Release a call

To release an active call, press F9 (Release).
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Basic Call Handling

Retrieve a held call

To retrieve (pick up) a held call, do one of the following:

= If the Pickup Indicator border appears on the associated call appearance,
press F4 (Pickup).

= Press ALT and the key (1 to 6) corresponding to the appropriate call
appearance.

= Click anywhere on the associated call appearance, except the information
button or comment area.

Make comments about a call

To make temporary notes while active on a call:
1. Click on the comments area of the call appearance.

2. Using the keyboard, enter a comment about the current call. The comment
remains until you delete it or release the call.

3. To exit the comments area, do one of the following:
m Click outside the comments area on the call appearance.
m Press TAB to access another call appearance.
m Click on a feature, trunk, or hundreds group button.

m  Select a new directory.

Issue 1 March 2002 7



Quick Reference

Conferencing Calls

Set up a conference call

=>» NOTE:
The Attendant Conference feature is not available in the CAS environment.

1. Answer or place the call that will be conferenced with up to five other
parties.

2. Press F6 (Conference).
3. Dial the extension or telephone number (including the trunk access code).
4. Do one of the following:

m If the called party has answered and wants to join the conference
call, press F7 (Add).

m If the called party does not answer or declines to join the conference
call, press F10 (Cancel).

Remove yourself from a conference call

To remove yourself from a conference call without affecting the connected parties,
press F9 (Release).

End a conference call

To end a conference call for all connected parties:

1. Press F11 (End Conf) on the call appearance associated with the
conference call.

2. When prompted by the dialog box, press ENTER or click OK.
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Transferring Calls

Transferring Calls

Transfer an incoming call (Auto Transfer)

You can use this method only when the Auto Transfer feature is administered for
your Softconsole:

1. Answer the incoming call, and press F5 (Transfer).

2. Dial the extension (using the keypad, DXS/BLF, or Softconsole directory).

Disable Auto Transfer for the current call

To disable the Auto Transfer feature for the current call so that you can announce
the call:

m Press SHIFT while dialing the number on the keypad.

m Press SHIFT-ENTER while dialing the number from the Softconsole
directory.

m Press SHIFT and click while dialing from the Busy Lamp Field.

Transfer an incoming call (Supervised)

1. Answer the incoming call, and press F5 (Transfer).

2. Dial the extension (using the keypad, DXS/BLF, or Softconsole directory) or
telephone number (including the trunk access code).

3. When the called party answers, announce the call.
4. Do one of the following:
m If the called party accepts the call, press F9 (Release).

m [f the called party declines the call, press F10 (Cancel) to reconnect
with the caller. Take a message (if necessary), and press F9
(Release).

m If the line is busy or no one answers, press F10 (Cancel) to
reconnect with the caller. Take a message (if necessary), and press
F9 (Release).
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Using the Softconsole Directory

Select a directory

The directories you can access and the activities you can perform in any directory
depend on the privileges your Softconsole administrator has assigned to you. If
more than one directory is available to you, the icon corresponding to the active
directory is highlighted on the directory panel and a checkmark appears next to
the appropriate directory name on the Directory menu.

To select another directory, press ALT and the key corresponding to the

appropriate directory name. Otherwise, click on the icon associated with the
directory.

Access the Directory menu

With the focus on the directory display, press ALT-D to access the Directory menu.

Find information in the directory

1. In the Sort By box, locate and click on the field name associated with the
type of search you want to perform.

2. In the Search box, type the string of text that you want the Softconsole to
locate.

=>» NOTE:
If you want to perform a “typedown” search, you can press any key in
the main keyboard area of your computer and pause to initiate the
search. To refine the typedown search, continue typing.

3. If more than one entry is displayed as a possible match, click on the
appropriate entry.

Add an entry to the directory

1. Do one of the following
m Access the Directory menu by pressing ALT-D, and press A (Add).
= On the Directory toolbar, click Add.

2. In the Add Directory Entry dialog box, enter the information for the first
field.

3. Press TAB to move to the next field.

4. When you finish entering information in all the fields for this new record,
press ENTER or click OK.
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Using the Softconsole Directory

Change information in the directory

1. Locate the entry you want to edit.

2. Do one of the following:
m Access the Directory menu by pressing ALT-D, and press E (Edit).
= On the Directory toolbar, click Edit.

3. In the Modify Directory Entry dialog box, change the necessary
information.

4. To save the changes, press ENTER or click OK.

Delete an entry from the directory

1. Locate the entry you want to delete.
2. Do one of the following:

m Access the Directory menu by pressing ALT-D, and press D
(Delete).

m  On the Directory toolbar, click Delete.

3. In the warning dialog box, press ENTER or click Yes to confirm that you
want to delete this entry.

Display detailed view of directory entries

To open a detailed view of directory entries as they are highlighted:
1. Do one of the following:

m Access the Directory menu by pressing ALT-D, and
press S (Show Details).

= On the Directory toolbar, click Show Details.

The detailed view (showing all the information associated with an entry)
appears in the lower part of the directory panel. If you can dial the numbers
associated with any of the fields displayed, a speed dial button appears on
the right side of the field.

2. To hide the detailed view, click Show Details again.
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Make notes in a directory entry

1. Locate the entry for which you want to make notes.

2. Do one of the following:
m Access the Directory menu by pressing ALT-D, and press E (Edit).
= On the Directory toolbar, click Edit.

3. In the Modify Directory Entry dialog box, move to the Notes area using the
mouse or TAB key, or press ALT-N (Notes).

4. Enter the necessary information in the Notes area.
5. Click OK to save the note.

Place a call using the directory

You can place a call directly from the Softconsole directory to any entry only when
no other call is active on the Softconsole.

1. Locate the person listed in the Softconsole directory.

2. With the directory entry highlighted, do one of the following to place the
call:

m Press ENTER.
m Double-click on the selected record.

m Click one of the alternate number call buttons in the detailed
information panel.

3. If the called party is busy or does not answer, press F9 (Release) and try
again later.

Send email using the directory

1. Locate the entry for the person to whom you want to send email.
2. Do one of the following to open your desktop mail application:
m Press ALT-M.

m Access the Directory menu by pressing ALT-D, and press M (Send
e-mail).

3. In the composition window, enter the message.
=>» NOTE:
If the directory entry contains a valid email address, that address is
automatically inserted in the “To” field of the email window.
Otherwise, you must enter the email address.

4. Click Send to send this message.
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Using the Softconsole Directory

View line status for a selected entry

While you are viewing a directory entry for an extension, press ALT-S to view the
line status for this entry.

The background color of the directory entry displayed changes to reflect the color
in the BLF cell corresponding to this extension.
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